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CHAPTER 1
INTRODUCTION

1.1 OVERVIEW

This chapter provides an overview of the M68ICS05C In-Circuit Simulator Kit components and
aQuick Start guide to setting up a development project.

The Motorola M68ICS05C In-Circuit Simulator Kit is a development toolkit for designers who
develop and debug target systems that incorporate M68HC705 C4, C8, and C9 (A)
Microcontroller Units (MCU) devices. The toolkit contains all of the hardware and software
needed to develop and simulate source code for and program the Motorola M68HC705C
microcontrollers.

Together, the M68ICSO5C printed circuit board (pod) and the ICSO5CW software form a
complete simulator and non-real-time 1/0O emulator for the M68HC705 C4, C8, and C9 (A)
devices. When you connect the pod to your PC and your target hardware, you can use the actua
inputs and outputs of the target system during simulation of code.

Use the M68ICS05C toolkit with any IBM-Windows 3.x or Windows 95-based computer with a
serial port.

1.2 TOOLKIT COMPONENTS

The complete M68ICS05C toolkit contains:
* Hardware:
— The M68ICS05C in-circuit simulator pod.
- Sample M68HC705C8A and M68HC705C9A EEPROM MCUSs.
— A 40-pin DIP target emulation cable.

* Windows-optimized software components, collectively referred to as ICSO5CW
software, and consisting of:

- WINIDE.EXE, the integrated development environment (IDE) software
interface to your target system for editing and performing software or in-
circuit simulation.

- CASMO5W.EXE, the CASM05W command-line cross-assembler.
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- ICSO5CW.EXE, the in-circuit/standalone simulator software for the
M68ICS05C target MCU.

Documentation:
— TheM68ICI05C In-Circuit Smulator Operator’s Manual.

— Technica literature, including Understanding Small Microcontrollers, an
introductory guide to understanding and using Motorola MC68HCO05 family
microcontrollers.

1.3 HARDWARE AND SOFTWARE REQUIREMENTS

The ICSO5CW software requires this minimum hardware and software configuration:

An IBM-compatible host computer running Windows 3.x or Windows 95 operating
system.

Approximately 640 Kb of memory (RAM) and 2 Mb free drive space.
A serial port for communications between the M68I CSO5C and the host computer.

1.4 TOOLKIT FEATURES

The M68ICS05C toolkit is alow-cost development system that supports in-circuit simulation. Its
featuresinclude:

1-2

Software and in-circuit simulation of M68HC705 C4, C8, and C9 (A) MCUs

Ability to program M68HC705 C4, C8, and C9 (A) EPROM microcontrollers
Communication with the host PC viaa seria port

|CSO5CW software, including editor, assembler, and assembly source-level simulator
64 instruction breakpoints

SCRIPT command for automatic execution of a sequence of commands

Emulation cable for connection to the target system

On-screen, context-sensitive Windows Help

CHIPINFO command supplies M68ICSO5C pod memory-map, vector, register, and
pin-out information

Software responds to both mouse and keyboard controls
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1.5 SPECIFICATIONS

Table 1-1 summarizes the M68I CS05C hardware specifications.

Table 1-1. M68I CS05C Specifications

Characteristic

Specification

Temperature:
Operating
Storage

0°to 40° C
-40°to +85° C

Relative humidity

0 to 95% (non-condensing)

Power requirement

+9 Vdc @ 0.1 A (maximum)

(from included wall transformer)

3.5x3.2in. (89 x 81 mm)

Dimensions

1.6 ABOUT THIS USER'S MANUAL

Thismanual covers the M68ICS05C software, hardware, and reference information as follows:
Chapter 2 0 Pod Installation
Chapter 30 Loading and Initializing the ICSO5CW Software
Chapter 4 0 WinIDE User Interface
Chapter 50 1CS05CW In-Circuit Simulator User Interface
Chapter 6 0 CASMO5W Assembler Interface
Chapter 7 0 1CS05CW Debugging Command Set
Chapter 8 0 Example Project
Appendix A O S-Record Information
Appendix B 0 M68ICS05C Support Information
Glossary
Index

M68ICS05COM/D 1-3



INTRODUCTION @ MOTOROLA

NOTE

The procedural instructions in this user's manual assume that you
are familiar with the Windows interface and selection procedures.

Figures in this manua show ICS05CW windows and dialog boxes
as they appear in the Windows 95 environment.

1.7 QUICK START INSTRUCTIONS

The following instructions summarize the hardware and software installation instructions of
Chapters 2 and 3.

If you are experienced in installing Motorola or other devel opment tools, follow these steps.

1-4

Install the ICSO5CW software: follow the instructions on the diskette label to run
the ICSO5CW Setup program. During installation, follow the instructions in the
installation wizard: choose the Typical Install option to install the files to your hard
disk, or choose the Compact Install option to copy the files onto another diskette.

Connect the M68ICS05C pod: connect the M68ICS05C pod to the host PC’s serial
port using the included cable. Plug the cable into the pod connector P2.

Supply power to the M68ICS05C pod: connect the wall-mounted transformer’s
circular connector to the connector on the left side of the pod, next to the serial
connector.

Start the WinIDE editor and open the project files: Double click the WinIDE icon.
From the WinIDE Environment menu, choose @pen Project option, and choose a
project file from theSpecify project file to open dialog. If no project file exists,
choose théNew option from the File menu to create a new project file. Paragraph 8.3
gives additional information about setting up a sample project.

Configure the environment for the ICSO5CW software components. from the
WinIDE Environment menu, select th&tup Environment option to open the
Environment Settings dialog and make the following changes:

— Click on theEXE1 Debugger tab to bring the tab (Figure 1-1) to the front. Set
the executable type, path and filename, command line options (including
optional switches, filenames, or port settings), and other options for the
ICSO5CW debugger application.
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Environment Settings | <]

[ General Ervironment T Gieneral Editor ]

Aszembler/Compiler {EXET [Debugger): E<E2 [Programmer]
Type IDehugger |
x Cancel |
EXE Path |c:\ics05cwl\CS05CWAICS05CW . EXE
| |

Options [%FILE.519% |

[~ Confirm Command line before running

[¥ Save all files before running

Figure 1-1. Winl DE Environment Settings Dialog EXE1 Tab

— Click on the Assembler/Compiler tab label to bring the tab (Figure 1-2) to the
front. Set the executable path and filename, type, and other options for the
CASMO5W assembler or other application.

Environment Settings

c:\ics05cwl \CASHWACASMOSW EXE
PLE CASMWxx Assembler e

Figure 1-2. WinI DE Environment Settings Dialog Assembler/Compiler Tab

— If necessary, change the programmer settings in theEXE2 (Programmer) tab.

— Click on the General Environment and General Editor tabs and make changes
in each as necessary.

—  When you have specified all the environment settings, press the OK button to
save the changes in the WINIDE.INI file and close the Environment Settings
dialog.

* Create a project filee The desktop and environment settings you make in the

Environment Settings dialog are stored in the WINIDE.INI file and read each time you
start the WinIDE editor. You may also choose to save project-specific desktop and
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environment settings in a project file (*.PPF) which is read when you open the
project, allowing you to save and use a general environment as well as custom
environments for individual projects. To create the project file:

— Specify the project-specific desktop and environment settings in the WinIDE
editor.

— Choose the Save Project As option from the WinIDE Environment menu to
name and save the project to a directory folder.

Run the ICSO5CW simulator: With a project or source file open in the WinIDE
main window, click the Debugger (EXEL) button (Figure 1-3) on the WinlIDE tool bar
to start the ICSO5CW debugger and debug the contents of the active source window.
Additional information about the ICSO5CW debugger can be found in Chapter 6 and

Chapter 7.
Figure 1-3. The WinI DE Debugger Toolbar Button

Assemble the code: Press the Assemble/Compile File button (Figure 1-4) on the
WIinIDE toolbar to assemble the source code in the active WinIDE window.
Additional information about the CASMO5W assembler can be found in Chapter 5.

3

Figure 1-4. The WinIDE Assemble/Compile File Toolbar Button

If you experience problems with the Quick Start procedures, refer to section B.3 for
troubleshooting instructions.

1-6
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CHAPTER 2
POD INSTALLATION

2.1 OVERVIEW

This chapter explains how to instal the hardware components of the M68ICS05C in-circuit
simulator on your host PC in both interactive and standal one modes.

When the M68ICS05C pod is connected to the serial port of a host PC, you can use the actua
inputs and outputs of your target system during simulation of your source code. When the pod is
not connected to the PC, you can use the ICSO5CW software as a standal one simul ator.

2.2 INSTALLING THE M68ICS05C POD

Before beginning, locate these pod components:
* Hardware reset switch S3
* Power On switch S1
*  9-pin RS-232 serial connector P2

e 9Volt Input Circular connector P1

To install the M68ICS05C Pod:

1. Connect the M68ICS05C pod to the serial port of your computer: attach the supplied
9-pin seria cable to the connector on the M68ICS05C board and attach the other end
to the host PC’s serial port.

2. Connect the 9-volt power supply: attach the power supply plug to the circular power
connector on the M68ICS05C pod and plug the power supply into a surge protection

device or wall outlet.

3. To run the ICSO5CW software with actual input and output from the target device,
connect the M68ICS05C pod to the 40-pin DIP socket on the target board using the
40-pin ribbon cable included in the M68ICSO5C kit. When this connection is
established and the pod and target system are started up, the target system will

provide inputs to and accept output from the ICSO5CW software.
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CHAPTER 3
SOFTWARE INSTALLATION AND INITIALIZATION

3.1 OVERVIEW

This chapter how to install and initialize the ICSO5CW software.

3.2 THE ICS05CW SOFTWARE COMPONENTS

The ICS05CW software consists of the following components:
*  WINIDE.EXE: the Windows Integrated Development Environment editor
 CASMO5W.EXE: the 6BHCO05 Cross Assembler

* |CSO5CW.EXE: thein-circuit Simulator, optimized for the HCOSCx-family Motorola
microcontrollers

3.2.1 TheWinIDE Editor

The WinIDE editor is atext editing application that lets you use several different programs from
within a single development environment. Use the WinIDE editor to edit source code, launch a
variety of compatible assemblers, compilers, debuggers, or programmers, and configure the
environment to read and display errors from such programs.

If you select error detection options in the Environment Settings dialog, the WinlDE editor will
highlight errors in the source code, and display the error messages from the compiler or
assembler in the editor.

To debug source code in the WinIDE code window, load compatible source-level map files. You
can configure the CASMO5W to produce such map files as an output.

Because the WinIDE editor is modular, you may, for example, choose to substitute a third party
C-compiler or other assembler for the CASMO5W cross assembler provided in the toolKkit.
3.2.2 CASMO5W

The CASMO5W is a cross assembler that creates Motorola S19 object files and MAP files from
assembly files containing 68HCO5 instructions.
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The CASMO5W assembler has the same functionality as the DOS version of the assembler,
optimized to take advantage of the Windows graphical environment. Using the assembler in
conjunction with the WinIDE editor, you can edit standard ASCII files (such as the .ASM
assembly files), and use menu options and toolbar buttons to call other customized assemblers,
compilers, or debuggers. The resulting environment can allow assembled files to be downloaded
and tested while the original source code is modified and assembled, al without leaving the
WinIDE editing environment.

Paragraph 5-5 gives additional information about assembler options and how to use them.

3.2.3 1CS05CW

The ICS05CW is asimulator for HC705C series microcontrollers that can get inputs and outputs
(I/O) for the device when the external M68ICS05C pod is attached to the host computer. If you
want to use 1/0 from your own target board, you can attach the M68ICS05C pod to your board
through the extension cable that comes with the toolkit. You can also program HCO5C devices
using the ICS05C board and ICS05CW software.

You can start or move to the ICSO5CW in-circuit ssmulator software from the WinIDE editor.
The ICSO5CW software can also be started using standard Windows techniques and run
independently of the WinIDE editor.

The ICS05CW simulator accepts standard Motorola S19 object code files as input for object code
simulation and debugging. If you are using a third party assembly- or C-language compiler, the
compiler must be capable of producing source-level map files to alow source-level debugging.

3.3 INSTALLING THE ICS05CW SOFTWARE

The ICSO5CW software is supplied on two 3.5" diskettes containing a setup program that
automatically installs the software on your hard drive.

3.3.1 Installation Steps

To install the software on your host computer’s hard drive, follow these steps:
1. Insert the ICSO5CW diskette into the 3.5-inch disk drive.
For Windows 3.x: in the Program Manager, select Run from the File menu.
For Windows 95: from the Start Menu, select the Run option.

2. In the Run dialog, enter Setup (or click the Browse button to select a different drive
and/or directory) and press OK.
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3. In the ICSO5CW Microsoft Setup Wizard, follow the instructions that appear on the
screen.

NOTE

Select either the Typical Installation type to install the files to your
hard disk, or choose Compact Installation to copy the files to
another diskette.

Table 3-1 lists the files and directories required to control the ICSO5CW program modules.

Table3-1. The |CS05CW Software Files

Directory Filename Description

Casmw casm0O5w.exe | Windows Cross Assembler for the 68HCO05

icsO5¢cw | icsO5cw.exe Windows In-Circuit Simulator
WinIDE winide.exe Windows integrated Development Environment (WinIDE) program
file
Winide.hlp Help for WinIDE

3.3.2 Starting the ICS05CW Software
Depending on the operating system you are using, choose the appropriate method for starting the
WinIDE software:

»  From the Windows 3.x Program Manager, double-click the WinIDE and/or ICSO5CW
icon(s).

*  From the Windows 95 Start Menu, select the WinIDE and/or ICSO5CW icon(s).

Y ou can start the ICS05CW simulator alone or from within the WinlDE.

3.3.3 ICS Communication

When you double-click the ICSO5CW icon, the software attempts to communicate with the pod
using the specified COM port, baud rate, and default parameters. When the software connects to
the pod, the Status Bar contains the message, " Contact with pod established.”

If the pod is not installed, or the ICSO5CW software cannot establish communications with the
pod through the specified COM port, the Can’t Contact Boardlialog appears, with options for
changing the COM port or baud rate and retrying the connection, or choosing to run the simulator
in standalone mode (with no input or output from the pod).
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NOTE

The COM port assignment defaults to COM 1 unless you specify
another port in the startup command.

The first time you attempt to connect to the pod after installing the ICSO5CW software, the
software asks you to select chip from the Pick Device dialog (Figure 3-1):

« OK X Cancel

Figure 3-1. The Pick Device Dialog

To open the Pick Device dialog, enter the CHIPMODE command in the ICSO5CW Status
Window command line.
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CHAPTER 4
THE WinIDE USER INTERFACE

4.1 OVERVIEW

This chapter is an overview of the WinIDE windows, menus, toolbars, dialogs, options, and
procedures for using each.

4.2 THE WINDOWSINTEGRATED DEVELOPMENT ENVIRONMENT

The Windows Integrated Development Environment (the WinIDE editor) is a graphical interface
for editing, compiling, assembling, and debugging source code for embedded systems using the
M68ICS05C In-Circuit Simulator.

The WinIDE interface consists of standard Windows title and menu bars, a WinIDE toolbar, a
main window containing any open source or project file windows, and a status bar. The WinIDE
components are labeled in Figure 4-1 and described in paragraph 4.3.2.
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TitleBar — poEETTIEEG] M E
Menu Bar__————— e Edt Envionment Sesch indow e

Toolbar — Y N R R C S
- D-ATIM\PROJECTS\MDDS51WECTORS ASM
o= DATIMPROJECTS\MDDST1YWORK ASM

Source Windows

i *

| = work_proc
*

| = This is the work procedure for the radio. We just keep looping
* through this procedure.
*

: work_proc: ; do forever

1da 26 ; update RIT every 32nd tim _I
sta rit_counter

workproc_1:

jsr keypad_get ; check keypad for input
dec rit_counter ; check if time to do RIT

bne workproc_1 s no, keep looping -
e

Main Window

i
Status Bar _ 16 [ Toek3s | Tom24 | Bues2m0 | Inset ﬂ

Figure4-1. Winl DE Window Components

4.3 WinIDE MAIN WINDOW

4.3.1 Main Window Functions

When you first start the WinlIDE editor, the main window opens without any source or project
files. As you open or create source files or a project, they appear as subordinate windows in the
main window. You can move, size, and arrange subordinate windows using standard Windows
techniques and the WinlDE Window menu options.

Use the WinIDE main window to:

* Open, create, edit, save, or print source (*.ASM, *.LST, *.MAP, and *.S19) or project
(*.PPF) file.

» Configure the desktop and environment settings for the editor, assembler, compiler,
debugger, and other programs.

* Launchthein-circuit ssmulator, compiler, debugger, or another program.

4.3.2 Main Window Components

Figure 4-1 shows how the WinIDE main window might look during atypical editing project, and
label s the standard window components:

» TitleBar: Thetitle bar appears at the top edge of the main window and contains:
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The application title,

The name of the target microcomputer application for which you are editing
source code,

The object file or files, if any (usually truncated),

Windows control buttons for closing, minimizing or maximizing the window.

* Menu Bar: The menu bar appears immediately below the title bar and contains the
names of the WinlDE menus.

* Toolbar: The WinIDE toolbar appears just below the menu bar and contains shortcut
buttons for frequently used menu options.

* Main Window: The main window area is the inside portion of the main window
which contains the open subordinate windows that you can resize, reposition,
minimize, or maximize using standard Windows techniques or Window menu
options.

e Status Bar: The status bar (Figure 4-2) appears along the bottom edge of the main
window and contains a number of fields (depending on the project) that show:

Source-file line and column numbers of the blinking insertion point cursor

System status or progress of the current window; for example, when the
window is edited, the status will be Modified

Total number of linesin the active window

Top: the current line position in the file of the top of the active window
Bytes: displays the total number of bytesin the active window
Insert/Overwrite mode: indicates the current typing mode

The status fields expand and contract as client area contents change and files become

active.

E:1

| Modfied | Totab11 | Top: 1 | Byess277 | Insett ‘

Figure4-2. Winl DE Status Bar

4.4 GETTING STARTED

4.4.1 Prerequisitesfor Starting the WinlDE Editor

Before you can start the WinIDE editor, the Windows operating environment must be running
and the ICSO5CW software must be installed in the host computer.

M68ICS05COM/D
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Remember that for the M68ICSO5C to run in simulation mode, the asynchronous
communications cable must connect the M68ICS05C pod on the platform board to the host
computer, and the power to the M68ICS05C pod must be on.

4.4.2 Startingthe WinIDE Editor

To start the editor, select the WinIDE icon by double-clicking the ICSO5CW Program Group
icon in the Windows 3.1 Program Manager or by selecting the icon from the Windows 95 Start
menul.

4.4.3 Opening Source Files

When the WinIDE editor opens, the main window is empty. To build the environment for your
project, choose the Open option from the File menu (or click the File button on the WinIDE
toolbar). In the Open File dialog, choose the files that will make up your project:

1. Select the drive containing the files from the Drives list.
2. Select the directory folder containing the files from the Folders list.

3. You may use the Filename text box to specify a filename or a wildcard/ extension to
filter the list of filenames (or choose a file type from the List files of type list). The
default file type is .ASM, but you can also choose:

*.c (source code files)
* Ist (listing files)

* txt (text files)

** (al files)

When al of the project files have been selected, click the OK button to open the files in the
WinlDE main window.

4.4.4 Navigating in the Winl DE Editor
To navigate among subordinate windows:
To navigate among the several sub-windows in which your project files are displayed in the

WinIDE main window:

¢ Choose the subordinate window’s filename from the Window menu or click on the
file' stitle bar to bring it to the front of the cascaded stack.

» If you have alarge screen or afew project files, you may choose the Tile option from
the Window menu to lay out al of the sub-windows so that all are visible, or choose
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the Cascade option to arrange all windows so that only the top window is entirely
visible.

* Regardless of how you arrange the windows, the title bar of all windows are visible.

To move between the WinlDE editor and the |CSO5CW simulator:

* From the WinIDE editor, click the External Program 1 toolbar button “ to switch
to the in-circuit simulator or the application which you have specified as the debugger
or other external program to use.

e From ICS05CW, click the Back to Editor toolbar button to toggle back to the
editor.

445 Using Markers

Markers provide a convenient way to mark multiple points in a file for navigating between
frequently visited locations while you are editing. You can set as many as 10 markers in source
filesin the WinIDE editor. A marker appearsin the file as a small button labeled with the marker
number.

When you save the project, the WinIDE editor saves the markers for all open edit files as well, so
that when you open the project again, the markers are still set.

To set amarker anywhere in thefile:
1. Placethe cursor on the line where you want the marker to be.
2. Press CNTL + SHIFT + N, where N is a value from 0 to 9 indicating the marker
number. A marker appears at the far left of theline.

To move to a marker, press CNTL + N, where N is denotes a marker number between 0 and 9.
Thisfeatureis useful if you are editing alargefile.

Markers can also be set, changed, navigated to, or cleared using options on the Edit shortcut
menu (Figure 4-3). Open the Edit shortcut menu by clicking the right mouse button in any edit
window.

B
e
Haste

Toogle Marker 0.9 »
Goto Marker 0.9 »
Clear Al Markers

Figure 4-3. Edit Shortcut Menu
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To set or clear amarker using the Edit shortcut menu options:

1. With the cursor in any editing window, click the right mouse button to open the
shortcut menu.

2. Position the cursor on the line where the marker should appear. Click the right mouse
button to display the shortcut menu.

3. Click the Toggle Marker 0-9 option to open the list of markers.

4. Click once on the marker to toggle. When the marker number is checked, it is toggled
on; when the marker number is unchecked, it is toggled off.

To move to amarker number using the shortcut menu options:

1. With the cursor anywhere in the edit file, click the right mouse button to open the Edit
shortcut menu .

2. Click on the Go To Marker 0-9 option to open the Marker sub-menu (Figure 4-4), and
choose the marker number to move to.

Toggle Marker 0
Toggle Marker 1
Togale Marker 2
Toggle Marker 3
Toggle Marker 4
Toggle Marker 5
Toggle Marker &
Toggle Marker 7

Figure4-4. Marker Sub-menu

You can execute many ICSO5CW menu options using either keyboard commands or toolbar
buttons. For example, to move to a marker, press the Ctrl + Shift + N key combination, where N
IS the marker number).

45 COMMAND-LINE PARAMETERS

The WinIDE editor lets you specify command line options to pass to each executable program.
The name of the currently edited file, or some derivative thereof, can be passed within these
options. To pass the current filename, specify a parameter %FILE%. The WinIDE editor will
substitute this string with the current filename at execution time. You may aso change the
extension of the passed filename, by specifying it within the %FILE% parameter. For example,
to specify an .S19 extension on the current filename the user would specify a %FILE.S19%
parameter.
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For example, if the current filename being edited isMYPDA.ASM:

Parameters passed to
Parameters specified program
%FILE% S L D MYPDA.ASM S L D
%FILE.S19% 1 @2 MYPDA.S19 1 @2

Although it is by default the currently edited filename that is used in the %FILE% parameter
substitution, the environment can be configured always to pass the same filename. Do this by
checking the Main File option in the Environment Settings dialog’'s General Options tab. This
technique is useful if you want to pass a specific filename to the external program without regard
t